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1.1

1.2

1.3

Introduction

Intended Use

INCA and INCA add-ons are developed and approved for automotive applications
and procedures as described in the user documentation for INCA and INCA add-
ons.

INCA-SIP (INCA Simulink” Integration Package) is an INCA add-on that provides
measurement and calibration access to MATLAB /Simulink” modelled ECU func-
tions via INCA. The INCA-SIP add-on is an additional Simulink” Toolbox.

INCA and the INCA add-ons are intended to be used in industrial labs and in test
vehicles.

ETAS GmbH cannot be made liable for damage that is caused by incorrect use
and not adhering to the safety information.

Target Group

This software product and this user guide address qualified personnel working in
the fields of automotive ECU development and calibration, as well as system
administrators and users with administrator privileges who install, maintain, or
uninstall software. Specialized knowledge in the areas of measurement and ECU
technology is required. This includes calibration procedures, software such as
INCA and MDA and software algorithms of systems you would like to calibrate.

Classification of Safety Messages

Safety messages warn of dangers that can lead to personal injury or damage to
property:

A DANGER

DANGER indicates a hazardous situation that, if not avoided, will result in death
or serious injury.

A WARNING

WARNING indicates a hazardous situation that, if not avoided, could result in
death or serious injury.
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CAUTION indicates a hazardous situation that, if not avoided, could result in

minor or moderate injury.

NOTICE

NOTICE indicates a situation that, if not avoided, could result in damage to

property.

Safety Information
Observe the following safety information when working with INCA and INCA add-

ons:
A WARNING

Risk of unexpected vehicle behavior

Calibration activities influence the behavior of the ECU and the systems that
are connected to the ECU.

This can lead to unexpected vehicle behavior, such as engine shutdown as well
as breaking, accelerating, or swerving of the vehicle.

Only perform calibration activities if you are trained in using the product and
can assess the possible reactions of the connected systems.

A WARNING

Risk of unexpected vehicle behavior

Sending messages via bus systems, such as CAN, LIN, FlexRay, or Ethernet,
influences the behavior of the systems connected to it.

This can lead to unexpected vehicle behavior, such as engine shutdown as well
as breaking, accelerating, or swerving of the vehicle.

Only perform the sending of messages via a bus system if you have sufficient
knowledge in using the respective bus system and can assess the possible
reactions of the connected systems.

Adhere to the instructions in the ETAS Safety Advice and the safety information
given in the online help and user guides. Open the ETAS Safety Advice in the INCA
help menu ? > Safety Advice.
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1.6

Data Protection

If the product contains functions that process personal data, legal requirements
of data protection and data privacy laws shall be complied with by the customer.
As the data controller, the customer usually designs subseguent processing.
Therefore, he must check, if the protective measures are sufficient.

Data and Information Security

To securely handle data in the context of this product, see the INCA Help section
‘Data and Information Security”.
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About INCA-SIP

INCA-SIP (INCA Simulink” Integration Package) is an INCA add-on that provides
measurement and calibration access to MATLAB®/Simulink” modelled ECU func-
tions via INCA. The INCA-SIP add-on is an additional Simulink” Toolbox.

If you follow the instructions in chapter "Installation” on page 14, a new menu item
will be available in Simulink”. This menu item establishes a connection between
INCA and your Simulink” model.

As part of the connection procedure, INCA-SIP creates various INCA objects (.a2),
819, INCA workspace) based upon the user's model. In addition, INCA-SIP
provides a number of search scripts that enable measuring and calibration of
models using standard Simulink” blocks. Customer-specific blocks can also be
measured and calibrated. To support such customer-specific blocks, custom
search scripts need to be written.

Connecting the Simulink” Model to INCA

During the model connection phase, INCA-SIP starts an analysis of the model
blocks (see the upper part in the figure chapter "Measuring and Calibrating the
Model" on the next page). You can customize the analysis to deal with customer-
specific blocks through custom search scripts.

After a successful connection, all parameters required for measurements and cal-
ibration access are determined and all artifacts required by INCA are generated.
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Measuring and Calibrating the Model

Within the INCA environment, the INCA-SIP add-on is presented as an XCP
device. INCA uses XCP to send and receive data to and from INCA-SIP, while
INCA-SIP exchanges data with the model via MATLAB”'s COM AP interface (see
figure lower part). Measurements from a Simulink” model can be received in INCA
when the Simulink” model is running, while calibration is also possible even if the
model is not under simulation, i.e. stopped or paused.

Simulink INCA-SIP INCA
21
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INCA-SIP INCA
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Cc— = Process = - -
Simulation ] i g

Analyzing the model (upper part) and M/C access (lower part) INCA-SIP

Technical Overview

Basic Operation

INCA-SIP is a suite of applications, libraries, and MATLAB® scripts that enables
measurement and calibration of Simulink” models by INCA. Most of INCA-SIP func-
tionality has been implemented in MATLAB® scripts. This enables extensive cus-
tomization of the suite, such as supporting customer-specific calibration and
measurement blocks. To an MC application INCA-SIP appears as an ASAM MCD-1
XCP V1.1.0 server that represents one or more “virtual ECUs" depending on the
underlying Simulink” model. The application such as INCA interacts with these
‘ECUs" as if they were real physical devices. Underneath, INCA-SIP exchanges
measurement and calibration data with a Simulink” model using the Microsoft
COM API'which communicates between the INCA-SIP Server executable and the
Simulink” Model.

INCA-SIP V7.5 | User Guide
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2.3.3

2.3.4

INCA-SIP MATLAB® Components

To use INCA-SIP, a path to INCA-SIP installation directory must be added to the
MATLAB® search path list. The installation contains s1 customization.m
script, which tells Simulink” to add INCA-SIP menu items to its Tools menu. Most
of MATLAB® specific functionality is implemented in an ETAS SIP Simulink block,
which needs to be added to the model being calibrated. Adding this block to a
model loads the INCA-SIP model containing the custom Simulink blocks and loads
the block.

Connection MATLAB® Side

With INCA-SIP, the connection is always initiated on the Simulink” side. The con-
nection process starts when the user selects Connect to INCA from the INCA-
SIP submenu. During connection, a MATLAB® script performs a find system()
call to retrieve all blocks in the model and loops through them to find blocks that
are suitable for calibration, such as Constant or Lookup Table blocks, and named
signals that could be used as measurements. The results of this analysis are
saved in three files:

File Description
Format

*.sipd SIPDis an XML file specific to INCA-SIP, which contains descriptions
of all measurements, calibrations, events, groups, and conversion
methods found during the analysis.

*.azl A2l contains essentially the same information, but in ASAM MCD2
MC (ASAP2) format that is recognized by most compliant MC applic-
ations. Applications such as INCA use this file to create meas-
urement and calibration variables for their variable selection dialogs.

*.s19 319 is a binary file containing memory offsets of the measurements
and calibrations in the Motorola S19 format.

Once the connection has been established, all subsequent interaction, for
example, sending calibration values and requesting measurement data during
visualization, is initiated by the MC application such as INCA. After connection,
the model is started in a paused state until a measurement is started.

Connection INCA Side

Once the A2L and S19 files have been generated, a MATLAB® script starts the
INCA-SIP COM server. After the server starts, the script starts INCA, creates all
the necessary INCA artefacts (the folder, the workspace, and the project) and
prepares the INCA Experiment Environment for visualization via a series of calls to
INCA COM API. Information in the A2L file is used to create the A2l project” in
INCA and represent each virtual ECU from the model as an “Ethernet System
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Simulation device” in the INCA Hardware Configuration Editor. After these steps
are complete, the user is ready to select MC variables, configure the experiment
layout and start visualization. As a final step, the connection script makes a COM
API call on the INCA-SIP server to start its XCP listener thread. At this point the
connection process is complete and INCA-SIP XCP server (slave) is ready to
accept commands from INCA.

Handling Measurements

When configuring the ECU, the rasters chosen in the ECU dialogue window
reflect how often INCA will receive updates on the model's measurements. If no
custom rasters are selected, a default raster of 100 ms is defined.

These rasters cannot be smaller than Simulink”’s in-built solver step and must be
a multiple of this solver step as well. Small rasters will lead to inefficient execution
time of the model due to the increased communication between INCA and
Simulink”.

During the model run, each time this raster time is triggered in Simulink”, a COM
event is sent to the INCA-SIP executable and triggers INCA-SIP to get the values
of all variables selected in INCA for that simulation point in time and cache it. If
multiple rasters are triggered at the same time for the same variable, it will use a
locally cached value.

In the case the variable is from a Simulink” ECU, for each value the INCA-SIP
executable will communicate via COM to the Simulink” model to getits latest
value. Ifitis a DLL ECU, the INCA-SIP executable will read the DLL loaded in
memory.

The SIP Server retrieves this measurement data and sends it to INCA in response
to XCP calls from INCA Target Server. The data appears in INCA as if it was
received from a physical ECU.

Simulink” - INCA Synchronization

The main purpose of this COM event approach from Simulink” is to throttle down
measurement data transmission rate to match the desired raster value. A
Simulink” model updates at its own solver step which can be several orders of
magnitude higher than the default raster of 100 ms and at a much faster rate at
which INCA can update its user interface, throttling the communication.

The INCA-SIP XCP server would get such a request through the COM event and
all variables will have to be updated before it continues the simulation time, to
ensure synchronization at a particular pointin time.

This can be seen by connecting an oscilloscope to the signal in the Simulink”
model: the graph will slow down to match the measurement rate determined by
the raster.
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Handling Calibrations

Changes in calibration values are sent to INCA-SIP in the form of XCP Server
requests. These changes are applied to corresponding block parameters in the
model only when INCA visualization is running. To fulfill the request, INCA-SIP
server posts a message to the Simulink” window of the running model whose
handle has been obtained when the connection was established. Simulink” then
executes an m-script, which sets the value of the block parameter specified in
the message.

Calibration is also possible even if the model is not under simulation, that means

stopped or paused. These changes will be reflected to the model once the meas-
urement is resumed in INCA.
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3.2

3.2.1

3.2.2

Installation

System Requirements

To work with INCA-SIP the following requirements must be fulfilled.

Hardware Requirements

The hardware requirements for the add-on are the same as for INCA and
MATLAB®/Simulink”. Refer to the respective manuals.

Software Requirements
To work with INCA-SIP V7.5 you need the following software components:
— INCA V7.5 including current hotfixes
— MATLAB/Simulink” (For supported versions, refer to the release notes.)

Installing

In this section you will find a description of the installation procedure and addi-
tional information about start menu entries and MATLAB® path modifications.

Installing INCA-SIP V7.5
This section describes how to install INCA-SIP V7.5.
To install INCA-SIP
1. Close all open ETAS programs.

2. Depending on your company-specific regulations, the installation files are
provided on DVD or on a network drive.

By using the DVD, the installation starts automatically. If this is not the
case, execute the Autostart.exefile.

or
If you install the program from a network drive, execute the Setup_ Ser-
vicePack.exe.

3. Inthe column "Install” select the checkboxes of INCA V7.5, MDA, INCA-SIP
and any further add-ons if needed.

Reqistering a C++ Compiler

If you use Rapid Accelerator Mode in Simulink” with INCA-SIP, you need a C++
compiler registered as a MEX compiler. Therefore, prior to using INCA-SIP with
Rapid Accelerator Mode, you have to register an external compiler, such as MSVC
(Visual Studio), as a MEX compiler. To register an external compiler, run a "mex -
setup” in the desired MATLAB® version before connecting INCA-SIP to INCA. For
the entire list of supported compilers, refer to the MATLAB® documentation.
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3.2.4

3.2.5

3.3

Start Menu

The Windows start menu folder contains the following entries once installation
has been completed successfully:

— E>ETASINCA V7.5 >INCA V7.5 Manuals and Tutorials
Opens a folder containing this manual and other support information.

— E>ETAS>ETAS License Manager
Starts the ETAS License Manager where you can view and manage licenses
for your ETAS software products (e.g. adding, borrowing, and returning
licenses).

Installation Path of INCA-SIP
The default installation path for INCA-SIP is:

64-bit <drive>:\Program Files\ETAS\AddOn SIP7.5\

® . .
MATLAB Script Files
If INCA-SIP is installed, the MATLAB® script files are stored under the following dir-
ectories:

64-bit <drive>:\Program Files\ETAS\AddOn
SIP7.5\+MScripts

The folder "+MScripts” contains MATLAB® script files that are either called by
INCA-SIP server or used by Simulink” to interact with INCA-SIP server and INCA.

Licensing
A valid license is required to use the software. You can obtain a license in one of
the following ways:

— from your tool coordinator

— viathe self-service portal on the ETAS website at www.etas.-
com/support/licensing

— viathe ETAS License Manager

To activate the license, you must enter the Activation ID that you received from
ETAS during the ordering process.

For more information about ETAS license management, see the ETAS License
Management FAQ or the ETAS License Manager help.

To open the ETAS License Manager help

The ETAS License Manager is available on your computer after the installation of
any ETAS software.

1. From the Windows Start menu, select E > ETAS > ETAS License Manager.
The ETAS License Manager opens.

2. Clickinthe ETAS License Manager window and press F1.


https://www.etas.com/support/licensing
https://www.etas.com/support/licensing
https://www.etas.com/en/downloadcenter/37717.php
https://www.etas.com/en/downloadcenter/37717.php
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The ETAS License Manager help opens.
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Working with INCA-SIP

This chapter contains information on preparatory measures and a description of
how to work with INCA-SIP.

MATLAB® Search Path Modification

To make INCA-SIP available in a particular MATLAB® version, add the INCA-SIP
installation path using the MATLAB® command addpath followed by savepath.
Referto 3.2.4 "Installation Path of INCA-SIP" on page 15 for path information.

Once the path is entered, the INCA-SIP menu item will be visible under the "Tools"
menu in the Simulink” window.

Switching between INCA Versions
You can have both INCA-SIP V7.5 and any other INCA-SIP V7 x installed on the
same computer although you use only one version at a time.

However, if you switch between INCA versions, it will be necessary to manually
change the path to the proper INCA-SIP version and to restart MATLAB®.

For more information, refer to "MATLAB® Search Path Modification" above.

Menu ltems

The INCA-SIP menu item contains the following functions:
— "Connect to INCA” below

— "ECUs" on page 19

— "Configuration” on page 23

— "MDF Configuration” on page 24

— Help

Connect to INCA

If you select this feature, INCA-SIP will start processing the associated model as
per the configuration settings. For each enabled ECU definition in INCA-SIP, the
calibrations and measurements are identified and processed. Each ECU defin-
ition is converted to an A2L and an S19 file. When the conversion process is com-
plete, INCA is automatically opened and a workspace is auto-generated in INCA.
For each ECU, a device is added in INCA with the corresponding project descrip-
tion and dataset.

INCA-SIP generates an EPK for each ECU.
The EPK is composed of:

— Ahashing function which considers the calibrations and measurements
present in the ECU

— The IP address of the network interface the ECU is made available on

INCA-SIP V7.5 | User Guide



— The associated TCP port

This ensures that a device on INCA will be connected to the appropriate Simulink”
model in INCA-SIP.

If the model is modified and you attempt to connect to INCA again, INCA-SIP
detects the changes and automatically replaces the datasets in INCA. If you have
an open experiment in INCA, INCA-SIP prompts you to save before closing the
experiment for you.

After the connection process is complete, INCA-SIP leaves the model in a paused
state in "Normal" and "Accelerated” mode. This will speed up the data collection
whenever measuring is started in the experiment window in INCA.
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ECUs

If you select this feature, the ECUs dialog box opens.

You have three options to choose for the ECUs being modeled:
— Add
— Remove
— Configure

INCA-SIP supports two types of ECUs, Simulink” and DLL ECUSs.

Simulink” ECUs represent ECUs that have measurements and calibrations which
exist as blocks within the Simulink” model.

Simulink” ECUs are divided in two types: Simulink” ECU and Referenced Model
Group.

The difference between these two types is that Simulink” ECU allows either map-
ping to the root model or one-to-one mapping to referenced models. On the
other hand, Referenced Model Group only allows one to many mapping to ref-
erenced models.

DLL ECUs represent ECUs that are used when an S-Function uses third party
DLLs in order to compute the S-Function result. Such DLLs can have global vari-
ables which can be considered as measurements and/or calibrations. DLL ECUs
provide a mechanism that exposes these variables as calibrations and meas-
urements in INCA.

To add a new ECU in Simulink”

1. Inthe Tools menu, select INCA-SIP>ECUs.

The "ECUs" dialog box opens.
2. Click Add in the "ECUs" dialog box.
The "Add ECU" dialog box opens.
3. Enter the required information in the following fields:
ECU Name: Name of the ECU. This field is macro compliant, refer to "Mac-

ros” on page 27.

ECU Type: Type of the ECU, Simulink” or DLL
4. Click Add.

The new ECU is added to the Simulink” model.

When you use DLL ECUs, INCA-SIP creates the following folders in the same
folder location as the Simulink” model.

— Aroof folder named "+ < SimulinkModelName >_DLL".

— Within the "+ «<SimulinkModelName >_DLL" folder, an additional folder
named "+ <ECUName>" is created. Note that the name of the ECU must be
a valid Simulink” package name.

— Within the "+ <ECUName>", two more folders are created:



+Calibrations |This folder contains search functions
which add calibrations.

+Measurements |This folder contains search functions
which add measurements.

DLL ECUs are auto detected if the model does not have any saved con-
figurations. If the model already has some configurations saved, you can add the
DLL ECU manually from the ECUs window.

To configure an ECU in Simulink”
1. Inthe Tools menu, select INCA-SIP>ECUs.
The "ECUs" dialog box opens.
2. Select the desired ECU.
3. Click Configure in the "ECUs" dialog box.

The "Configure ECU" dialog box opens.
4. Enter your configurations.

For more information, refer to "Individual Tab Description” below.
5. Click Save.

Individual Tab Description

General

This tab contains settings related to how a specific ECU will connect to INCA.

Enabled If enabled, this ECU will be used. If disabled, INCA-SIP will skip
processing this ECU.

Regenerate  |If disabled, INCA-SIP will not generate the A2L and S19 files,

A2l and S19  |assuming that the content of the existing files is correct. This
file can be used to speed the processing time when connecting.
INCA-SIP can decide to ignore this flag if it deems that the exist-
ing files are not using the latest formats, or if any of the files are
missing. In this case, a corresponding information message will
be reported.

ECU Name Name of the ECU. Note that this field is macro compliant. For
(read only) more information, refer to "Macros" on page 27.

S19 File Name | Path containing the name of the S19 generated file. Note that
this field is macro compliant. For more information, refer to "Mac+

ros” on page 27.

A2L File Name |Path containing the name of the A2L generated file. Note that
this field is macro compliant. For more information, refer to "Mac
ros” on page 27.




SIPD File Name | Path containing the name of the SIPD generated file. The SIPD
file contains a full description of the ECUs events, calibrations,
measurements, and groups. Note that this field is macro com-
pliant. For more information, refer to "Macros” on page 27.

Subsystem A sub path within the model which this ECU will represent. Pro-

(visible only in |cessing for measurement and calibrations will be limited to this

Simulink” path and its children. Note that this field is macro compliant. For

ECUS) more information, refer to "Macros" on page 27.

Referenced  |Name of the referenced model this ECU represents. If set as

Model (visible |N/A, the ECU represents the root model.

onlyin

Simulink”

ECUS)

IPv4 Address | The IPv4 address of the network interface the XCP Slave will be
listing on. If an IP address is configured and such IP is no longer
valid, INCA-SIP will revert the configuration to the Loopback IP
(127.0.0.7).

XCP TCP Port | The XCP Port on which the ECU XCP Slave service will be listen-
ing on. If set to -1, INCA-SIP will allocate a random port for this
ECU and will save it in the associated configurations.

All/Selection | All includes all referenced models that exist in the connection

o . |phase. The selection allows a subset of the referenced models

(visible only in to be mapped to the ECU, which can be selected using the

Referenced | Model List function.

Model Group

ECUs)

Events

Events can be defined to create rasters in the ECU, which are calculated in
seconds. These decide how often SIP expects updates from the Simulink” model.
A default raster of 0.1 seconds is setup in this window.

If the raster time is O, the DAQ will send the data with each solver step in
Simulink”. Small raster values or using raster time 0 with a very small, fixed solver

time in Simulink”

cution.

are possible but can become inefficient and cause to a slow exe-

Araster that is smaller than the fixed solver time or a raster that is not a multiple
of the solver is not possible and will be marked invalid on INCA connection. This is
because these rasters would not all be able to be triggered and some will be

skipped.

Using variable solver time is not recommended as it cannot be determined if the
raster will be hit or not, or how often Simulink” will be updated.
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Search Functions

The two tables contain the search scripts available for that ECU. They are sep-
arated in two tables: one for calibration and one for measurement. Multiple selec-
tion is possible by holding SHIFT pressed down. You can deselect a single item by
holding CTRL pressed down.

Simulink” ECUs come with default supported calibration search scripts for
Simulink” blocks, these are: Basic Gain, Basic Lookup 1D, Basic Lookup 2D, Basic
Lookup 3D, Table Lookup nD, Direct Lookups nD, Interpolation Blocks nD, Prelook-
ups, and Generic S-Function Masked Parameters.

Note that nD implies all dimensions from 1D to 4D.

For measurements, Simulink” ECUs support searching for named lines that are
connecting blocks. Each line is followed to its data source(s). The Runtime
Objects of the outports composing the measurement will then be used for data
collection.

DLL ECUs search scripts for these ECUs need to be written specifically for the
custom DLL(s) being calibrated and measured. For more information, refer to
chapter "Creating a DLL Search Script” on page 33 on how to create these cus-
tom scripts.

If the same calibration is in multiple ECUs, calibrating it on one ECU will not
update the dataset of the other ECUs in INCA. This will result in a checksum error
when reinitializing the hardware from INCA.

INCA-SIP V7.5 | User Guide



4.3.3 Configuration

If you select this feature, you can configure INCA project creation settings.

To configure INCA project creation settings

1. Inthe Tools menu, select INCA-SIP> Configuration.

The "Session Configuration” dialog box opens.

2. Enter your configurations.

For more information, refer to "Session Configuration Description” below
and "Remote INCA Configuration” on the next page.

3. Click OK.

Session Configuration Description

Compile Model

If disabled, when Connect to INCA is pressed, the
Simulink” Model is not compiled.

You need compilation to generate measurements,
hence, if a Simulink” ECU is using the BasicNameSi-
ginals Search Script and has the Compile Model
unchecked, it will result in no measurements being vis+
ible in INCA unless the Regenerate A2L and S19 file is
unchecked and files already exist.

Open INCA On Connect

If enabled, INCA opens and the automatic con-
figuration of the workspace is done.

If disabled, the A2L and S19 files are still generated (if
needed), the XCP slave is initiated, but INCA will
neither be opened nor configured.

INCA Database

The path of the directory INCA should save the INCA
database for INCA-SIP. Note that this field is macro
compliant. For more information, refer to "Macros” on

page 27.

INCA Folder

The name of the INCA folder in the INCA Database.
Note that this field is macro compliant. For more
information, refer to "Macros” on page 27.

INCA Workspace

The name of the INCA project Workspace. Note that
this field is macro compliant. For more information,
refer to "Macros" on page 27.




4.3.4

Remote INCA Configuration

Remote INCA Con-
nection

If enabled, INCA-SIP opens INCA on the remote
machine via DCOM.

INCA Machine DNS The host name or IP address of the remote INCA
Name/IP Address machine.
Root Network Path Common UCN path that the INCA machine and the

MATLAB® machine can access.

For more information, see "Using INCA Remotely” on page 42.

@ Note

page 28.

The default Simulink” ECU contains the Emulation Mode Controls in the
A2L. For more information, refer to "INCA-SIP Emulation Mode" on

If Show Workspace/DD Variables is enabled, each ECU will have a new group in
the Variable Selection Dialog. The new group contains all the variables used by
the model which are either in the global workspace, in the local workspace, or in

the data dictionary.

MDF Configuration

If you select this feature, you can configure the MDF stimulus.
To configure INCA the MDF stimulus

1. Inthe Tools menu, select INCA-SIP > MDF Configuration.

The "MDF Configuration” dialog box opens.

2. Enter your configurations.

For more information, refer to "MDF Configuration Description” on the next

page.
3. Click OK.




MDF Configuration Description

Use MDF Stimulus

If enabled, INCA-SIP will allow loading external stim-
ulus from MDF files to inputs in Simulink”. Once con-
nected INCA-SIP will validate that the stimuli are
loaded.

Stimulus File

The MDF file from which the stimuli will be loaded and
mapped. Note that this field is macro compliant. For
more information, refer to "Macros" on page 27.

Mapping File

The configuration file defining the Mapping MDF sig-
nals from the Stimulus file to the inputs in the
Simulink” Model. If the file does not exist,INCA-SIP will
generate it automatically when the mapping tool is
used. Note that this field is macro compliant. For
more information, refer to "Macros" on page 27.

Mapping Tool

Opens the MDF Mapping tool. This tool will allow to
map MDF signal to inputs in the Simulink” Model. The
left hand side tree shows the ports in Simulink” to
which data can be coupled with. The right hand side
table contains all the data from the MDF file. The MDF
data can be dragged onto the Mapping Value column
to map the data of that column to the required inport.

INCA-SIP loads the data for the selected MDF stimuli
from time = O till time = <simulation time>. If the sim-
ulation time is extended, the mapping tool needs to
be re-used to load the data to the newly specified
simulation time.
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Using the MDF Mapping Dialog

4\ INCA-SIP MDF Mapping Tool X
Tools
MDFDemo MDF Signal;
# 1n0T: In07 - All_Samples (GID:2)
# 1n02: In02 - All_Samples (GID:2) MDF Signal Raster Group Index
::gj In0T\MDFDemo All_Samples 1 ~
» Inos: - In02\MDFDemo All_Samples 1
» Inds: - In02_[0]\MDFDemo All_Samples 1
107 In02_[1]\MDFDemo All_Samples 1
1n08 In03_[2]\MDFDemo All_Samples 1
* Inog: - In03_[3]\MDFDemo All_Samples 1
* InlD: - In03_[4]\MDFDeme All_Samples 1
In11 In03_[5]\MDFDeme All_Samples 1
Inl2 In03_[6]\MDFDeme All_Samples 1
& Inl3 - In04_[0]\MDFDemo All_Samples 1
& Inld - In04_[1]\MDFDemo All_Samples 1
s In04_[2]\MDFDemo All_Samples 1
CniE In04_[3]\MDFDemo All_Samples 1
In04_[4]\MDFDemo All_Samples 1
In04_[5]\MDFDemo All_Samples 1
In04_[6]\MDFDemo All_Samples 1
InD5\MDFDemo All_Samples 1
In0DE\MDFDemo All_Samples 1
In07_[0]\MDFDemo All_Samples 1
In07_[1]\MDFDemo All_Samples 1
In07_[2]\MDFDemo All_Samples 1
In07_[3]\MDFDemo All_Samples 1
In07_[4]\MDFDemo All_Samples 1
In07_[5]\MDFDemo All_Samples 1
In07_[6]\MDFDemo All_Samples 1
In08_[0]\MDFDemo All_Samples 1
InD8_[1]\MDFDemo All_Samples 1
In0E_[2]\MDFDeme All_Samples 1 v
Simulink Port Tree oK Cancel MDF Signals Table
Drag MOF signals on to Simulink ports Showing 67 of 67

To map a signal

— Inthe "MDF Mapping Tool" window, drag the desired MDF signal and drop it
ona Simulink” port.
The Simulink® ports can be identified by the following icon: *

or

1. Select a Simulink” port.

2. Double-click on the desired MDF signal to map it to the port.

Clearing MDF Mappings

To clear all mappings

— Inthe "MDF Mapping Tool" window, select Tools > Clear All Mappings.
or
— Right-click on the Simulink” port tree and select Clear All Mappings.

To clear individual mappings

1. Selectaport or a tree node.
2. Pressthe <DEL> key.
or
— Right-click on the Simulink” tree and select Clear Selected.

The selected node and all of its children are cleared.

@ Note

This operation cannot be performed on the root node.
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4.4

Updating the Simulink” Ports

To map MDF signals to Simulink” ports, the model must be compiled. INCA-SIP
uses the last known configuration (if available) to avoid recompiling the model
every time the mapping tool is opened. This last known configuration may be out-
dated.

To update the Simulink’ port tree
1. Inthe "MDF Mapping Tool" window, click on Tools.
2. Reload Simulink” ports from the "Mapping” dialog.

Updating MDF Signal Data
For performance reasons, the MDF data is stored as part of the model workspace.
This data may be out of date, so manual updating is necessary. For example, if
the MDF file is changed or replaced with the same MDF file name and path.
To update the MDF signals

1. Inthe "MDF Mapping Tool" window, click on Tools.

2. Reload MDF data from the "Mapping” dialog.

@ Note

There are cases where the data is automatically reloaded when connecting to

INCA:

— If INCA loads the MDF data, the simulation time is taken into account and
only the required amount of data is loaded. If the simulation time is changed
to alonger duration, the data is automatically reloaded.

— If the MDF path is changed in the MDF configuration window, the cached
MDF data is deleted so that it is automatically reloaded when connecting.

— IfaSimulink” port is changed and the assignment becomes invalid, the MDF
data for that port is deleted and automatically reloaded (if reassigned) when
connecting.

Macros
INCA-SIP supports macro variables in strings to provide you dynamic strings. You
can perform the following macro variables:

— $(SystemName) : Resolves to the name of the model.

— $ (ECUName) : Resolves to the name of the ECU (can only be used in ECUs

Configuration window).
— $(INCADataDir):Resolves to the INCA data directory path.
— S$(INCASIPDir):Resolves toINCA-SIP Installation path.

INCA-SIP also supports environment variables in macros, e.qg. $ (APPDATA) %.
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Naming Conventions

Calibrations and Measurements

When INCA-SIP processes an ECU, it will generate an A2L file. Hence, any names
for measurements and calibrations need to be compliant with the A2L cal-
ibrations and measurement names. Non-compliant names are renamed accord-
ingly. In addition, if there are any name conflicts, INCA-SIP adds _x to the name,
where X is an integer in the range 1to infinity.

Groups

You can define measurements and calibrations to exist in Groups, shown in
INCA's Variable Selection Dialog (VSD). If there are any name conflicts between
group names in the same ECU, INCA-SIP willadd _x to the name, where x is an
integer in the range 1to infinity.

= Variable Selection

e —————— [ | X = @W® T THHEY

Sources

Hint outi 4. £ @] All Sources
= <% Demo

SubSystem 2 @) Rasters
= [—‘@ Groups
s W 1 = Egl pemo
L) ETas st
Canst [‘@ SubSystem_1

["@ SubSystem_2

The "ETAS_SIP" Group will contain the controls related to the INCA-SIP Emulation
Mode.

INCA-SIP Emulation Mode

INCA-SIP provides two modes of model simulation:
— "Real-Time Emulation Mode"
— "Fast Emulation Mode"

These controls are available in the "Default Simuling ECU" in the A2L file in the
"ETAS-SIP" group.

Real-Time Emulation Mode

In Real-Time Emulation Mode, the INCA-SIP add-on attempts to approximate real-
time simulation. Therefore, if the model is simulating faster than real-time use-
case, INCA-SIP will throttle the model simulation to near real-time. On the other
hand, INCA-SIP has no effect on model simulation when it is simulating slower
than real-time.

This mode is ideal in the case the user would like to calibrate the model during
simulation and visualize the effects of the calibration on the simulation.
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4.6.2

4.7

4.8

To activate this mode of operation, within the associated INCA experiment, you
need to add the RealTimeBlock.mode calibration and select the "Real Time"
option. The RealTimeBlock.realTimeMultiplier calibration can be used to
change the throttling multiplier as described below:

Equalto1 Represents real time
Lessthan1 Represents slower than real time
Greater than1 Represents faster than real time

Less than orequal to 0 |Are equivalent to INF, which represents the Fast Emu-
lation Mode

You can find these calibrations in the "ETAS_SIP" group in the "Default Simulink
ECU".

Fast Emulation Mode

In Fast Emulation Mode, during model simulation, the INCA-SIP add-on transmits
data to INCA as fast as possible, while ensuring no data loss.

Therefore, this behavior makes it impractical for data visualization. This mode is
ideal in case you would like to make offline calibration changes and then simulate
the model for a fixed period of time. This model simulation should be complete in
arelatively short period of time, while the measured data can then be analyzed
offline through MDA (Measure Data Analyzer).

In order to activate this mode of operation, within the associated INCA exper-
iment, you need to add the RealTimeBlock.mode calibration and select the
"Fast Emulation” option. You can find these calibrations in the "ETAS_SIP" group
in the "Default Simulink ECU".

INCA-SIP and Block Reduction

MATLAB® supports block reduction by default. The calibrations and meas-
urements can be optimized or eliminated from the simulation if these are deemed
to have no effect on the simulation. INCA-SIP ignores such calibrations and meas-
urements. You can enable and disable block reduction from the simulation set-
tings. For more information, refer to the MATLAB® documentation.

Simulation Modes
MATLAB® provides various simulation modes. INCA-SIP supports the following
modes:

— Normal Mode

— Accelerated Mode

— Rapid Accelerated Mode
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@ Note

Rapid Accelerated Mode needs a working registered C++ compiler to
work. For more information, refer to "Registering a C++ Compiler” on

page 14.

@ Note

Due to changes in new MATLAB® versions, Rapid Accelerated mode is
only supported on MATLAB® Version 2018b and below.

Referenced Models Support

Referenced models are normal models in Simulink . These models are referenced
by a parent model, allowing the parent model to link to the referenced model's
inputs and outputs. When configuring an ECU, it can be configured to pointto a
specific referenced model by choosing the referenced model's name from the
combo box.

Referenced models are shown as a separate ECU in INCA.

Refusing Calibrations

There can be cases where MATLAB® Simulink” refuses calibrations sent by INCA.
One such example is when you use a workspace variable as table data and axis
data at the same time. In such case, the axis data need to be increasing mono-
tonically while the table data has no such restrictions. If the table data is cal-
ibrated and monotonicity is broken, MATLAB® will refuse this calibration. The error
code CALMEM REQUESTNOTVALID beingreturned by XCP is displayed in the
INCA Monitor window.

Busy ECU

Some requests may be time consuming and will place the ECU in a busy state.
One such example is when calibrating a large array at one go by doing incre-
ment/decrement on all elements together. In such case, the ECU is busy with the
execution of this request and INCA will show a dialog until the ECU is free again
and is able to receive the next command.

Starting and Stopping the Experiment

To start the experiment

1. In the INCA Experiment window, click [> or press F11.
The simulation in Simulink” behaves as follows:

Start if the simulation was in a stopped state.
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or
Continue if simulation was in a paused state.

To stop the experiment

1. Inthe INCA Experiment window, click stop [- or press F9.
The simulation in Simulink” behaves as follows:
Pause in Normal and Accelerated Mode.

or

Stop in Rapid Accelerated Mode.

@ Note

The simulation state is changed in the above cases only if there are some
measurements selected in the INCA experiment.

Simulink.Signal and Asap2.Signal Support

In Simulink” ECUs, if a named line is named after a Simulink.Signal or Asap2.Signal,
the measurement will take the "Description”, "Unit", "Min" and "Max" from the Sim-
ulink.Signal or Asap2.Signal variable.

Simulink.Parameter and Asap2.Parameter Support

In Simulink” ECUs, if a supported block has a parameter with the content of a
workspace variable of type Simulink.Parameter or Asap2.Parameter, the cal-
ibration will take the "Description”, "Unit", "Min" and "Max" from the Sim-
ulink.Parameter or Asap2.Parameter variable.

Error, Warning and Information Messages
INCA-SIP displays error, warning and information messages during the con-
nection and simulation process.

Messages related to an open Simulink” model are logged in the Simulink”'s Dia-
gnostic Viewer.

Toopen Simulink”’s Diagnostic Viewer

1. Inthe Simulink” editor, click View > Diagnostic Viewer.

MATLAB® also opens the Diagnostic Viewer whenever an error message is
logged.

DLL Mode

In MATLAB®, you can write an S-function which internally uses DLLs at some
stage of its processing. The INCA-SIP DLL mode provides support to calibrate and
measure global variables within a DLL.
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Creating the DLL

You can find a sample Visual Studio Project under

<drive>:\ETASData\INCA7.5\Demo\AddOn INCA-SIP7.5\SIPDllDemo.

The contents of the "SIPDIIDemo” folder are described below.

acy alg sfcn.c

"legacy_alg” [Contains the sample DLL which we will be calibrating and meas-
uring from INCA. When the solution is built, it will copy the DLL
and the map file to the "x64" folder. The map file is used to
determine the module and variables offset.

"X64" Used in a 64-bit MATLAB® version, this folder contains the

model and the DLL search scripts. To use this project, the 1leg-
acy alg sfcn.cfile needs to be compiled usingmex leg-

In the source code, there are a number of global variables which can be measured

or calibrated.

@ Note

ibrating the variables.

No synchronization mechanisms are in place between SIP and the DLL.
Therefore, race conditions can occur if INCA-SIP is not the only actor cal-

INCA-SIP supports the following types for DLL Mode:

INCA-SIP DLL Type CType Size  Remarks
MScripts.Dl1lMode. uint8_t 8
D11Asap20bject.UINTS

MScripts.Dl1Mode. uint16_t 16
Dl11Asap20bject.UINT16

MScripts.Dl1Mode. uint32_t 32
D11Asap20bject.UINT32

MScripts.Dl1Mode. uinté4_t 64 Calibrations Only
D11Asap20bject.UINT64

MScripts.Dl1lMode. int8_t 8
D11Asap20bject.INT8

MScripts.Dl1lMode. int16_t 16

D11Asap20bject.INT16




4.16.2

INCA-SIP DLL Type C Type Size  Remarks

MScripts.Dl1lMode. int32_t 32
D11Asap20bject.INT32

MScripts.Dl1lMode. int64_t 64
D11Asap20bject.INT64

MScripts.Dl1Mode. uint8 8
D11Asap20bject .BOOL

MScripts.Dl1lMode. float 32 |EEE-754
Dl11Asap20bject.FLOAT

MScripts.Dl1Mode. double 64 [EEE-754
D11Asap20bject.DOUBLE

@ Note

int64 and uint64 will only work with calibrations. If used in measurements,
these will be seenin INCA and in the Variable Selection Dialog but cannot
be selected.

Creating a DLL Search Script

You can find sample scripts under

<drive>:\ETASData\INCA7.5\Demo\AddOn INCA-SIP7.5\SIPDLLDe-
mo\x64\+SipDl1lDemo_ DLL\+D1l1Demo

Each search script is defined by having a function defined by the following func-
tion signature:

<Function Name >(dataModel, sRootSystem)

The "dataModel” is the object to which calibrations and measurements need to
be added. "sRootSystem” is a string with the name of the model.

DataModel Function Calls

Function addCalibration (calibration)

Parameters  calibration Calibration Description Object

Return Value None

Description  Adds this Calibration Description Object to the data model to be
shown in INCA. All axes associated to the calibration will be
added automatically.

Function addCalibrationAxis (axis)
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Parameters

axis Calibration Axis Description
Object

Return Value

None

Description  Adds this Calibration Axis Object to the data model to be shown
in INCA. This should only be used if you intend to show a stand-
alone calibration axis which was not associated to any Cal-
ibration Object.

Function addMeasurement (measurement)

Parameters measurement Measurement Description

Object

Return Value None

Description

Adds this Measurement Description Object to the data model
to be shown in INCA.

Once you have defined a DLL calibration and have set all its properties, you need
to add it to the data model. You can achieve this by:

dataModel.addCalibration (calibration);

@ Note

An axis object should only be linked to one calibration. Should you want
to link the same module offset to another calibration as an axis, another
instance of the axis should be created.

If the calibration had a linked axis to it, you do not need to add the axis since
these will be added automatically.

If an axis is not linked to any calibration, you can add it by:

dataModel.addCalibrationAxis (axis) ;

Once you have defined a DLL measurement and have set all its properties, you
need to add it to the data model. You can achieve this by:

dataModel.addMeasurement (measurement) ;
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Creating Object Using DIlAsap20bjectFactory

Creating Calibrations

TheMScripts.Dl1Mode.Dl1Asap20bjectFactory provides the following
methods to create calibrations:

Function createScalarCalibration (name, moduleOffset,

cDataType, dllName, groupPath)

Parameters name Name as it will be shown in INCA

moduleOffset Module offset address hex string
of the varable in the DLL

chataType Type of the data at the module
offset
dllName The name of the DLL where the

module offset is located

groupPath Group in which the calibration will
be shown in INCA

Return Value Calibration Description Object

Description  Creates a scalar calibration which is visualized as a simple cal-
ibration in INCA.

Function createTableCalibration (name, moduleOffset,
cDataType, dllName, groupPath)

Parameters name Name as it will be shown in INCA

moduleOffset Module offset address hex string
of the variable in the DLL

cDataType Type of the data at the module
offset
dllName The name of the DLL where the

module offset is located

groupPath Group in which the calibration will
be shown in INCA
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arraySize The size of the array in vector
format (e.g. [13] or [23 4])

Return Value

Calibration Description Object

Description  Creates a n-dimensional calibration which is visualized as a cal-
ibration in INCA.

Function createFixedAxis (offset, distance, num-
berOfAxisPoints, asap2Description)

Parameters offset Start value of the Fixed Axis
distance Increment Size
numerOfAxisPoints Number of elements in the

axis

Return Value

Fixed Axis Description Object

Description

Creates fixed axis. This can only be linked to a n-dimension cal-
ibration. Note that all n-dimension calibrations have assigned to
them a fixed axis by default .

Function

createCalibrationAxis (name, moduleOffset,

cDataType, dllName, groupPath, arraySize)

Parameters

name Name as it will be shown in
INCA

moduleOffset Module offset address hex
string of the variable in the DLL

cDataType Type of the data at the module
offset
dl1lName The name of the DLL where

the module offset is located

groupPath Group in which the calibration
will be shown in INCA

arraySize The size of the array in vector
format (e.g. [13] or [234])

Return Value

Calibration Axis Description Object

Description

Creates an axis. This can be linked to a n-dimension calibration
or added to the data model without being linked to a Table Cal-
ibration.
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Function createCalibrationAxisWithMeasurementKey (name,
moduleOffset, cDhataType, dllName, groupPath,

arraySize, sMeasurmentKey, hDataModel)

Parameters name Name as it will be shown in
INCA
moduleOffset Module offset address hex

string of the variable in the DLL

chataType Type of the data at the module
offset
dllName The name of the DLL where the

module offset is located

groupPath Group in which the calibration
will be shown in INCA

arraySize The size of the array in vector
format (e.g. [13] or [234])

sMeasurmentKey The Measurement Key of the
measurement which relates to
this axis

hDataModel Handle to the data Model

Return Value Calibration Axis Description Object

Description  Creates an axis. This can be linked to a n-dimension calibration
or added to the data model without being linked to a Table Cal-
ibration.

@ Note

It is the responsibility of the user to ensure that the module offset and
the array sizes are correct.

Linking an Axis to a Calibration

If you would like tolinkaDLL Axis Calibration to a DLL Table Cal-
ibration, you can do the following on Calibration Description Objects:

Function setAxis (axis, index)
Parameters axis Calibration Axis Description Object
index Index of axis e.q. 1=X axis, 2=Y axis, 3=Z

axis, 4=W axis
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Return Value

None

Description

Associates an axis to Calibration Description Object.

Creating Measurements

TheMScripts.Dl1Mode.Dl1Asap20bjectFactory provides the following
methods to create measurements:

Function createScalarMeasurement (name, moduleOffset,
cDataType, dllName, groupPath, arraySize)
Parameters name Name as it will be shown in
INCA
moduleOffset Module offset address hex

string of the variable in the DLL

cDataType Type of the data at the module
offset
dllName The name of the DLL where the

module offset is located

groupPath Group in which the calibration
will be shown in INCA

Return Value

Measurement Description Object

Description  Creates a Scalar measurement which is visualized as a simple
measurement in INCA.

Function createArrayMeasurement (name, moduleOffset,
cDataType, dllName, groupPath, arraySize)

Parameters name Name as it will be shown in INCA
moduleOffset Module offset address hex

string of the variable in the DLL

cDataType Type of the data at the module
offset
dl1Name The name of the DLL where the

module offset is located

groupPath Group in which the calibration
will be shown in INCA
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arraySize The size of the array in vector
format (e.g. [13] or [23 4])

Return Value Measurement Description Object

Description  Creates a n-dimensions measurement which is visualized as a
collection of simple measurements in INCA.

@ Note

The name must follow ASAP2 naming conventions. If it is not adhered to,
INCA-SIP renames the measurement/calibration to make it compliant. Sim-
ilarly, if the same name has already been used in the ECU, then _x will be
appended to the name, where X is an auto-incrementing integer ranging
from 1to infinity.

@ Note

It is the responsibility of the user to ensure that the module offset and
the array sizes are correct.

General Options

All objects can have a description, minimum and maximum values set using the
function calls below.

Function setAsap2Description (sDescriptionText)

Parameters  sDescriptionText Description Text

Return Value None

Description  Sets description for object.

Function setAsap2MinValue (dMin)

Parameters dMin Minimum Value

Return Value None

Description  Sets minimum allowed value.

Function set2AsapMaxValue (dMax)

Parameters dMax Maximum Value

Return Value None

Description  Sets maximum allowed value.




Function addGroupPath (sGroupPath)

Parameters  sGroupPath Group in which the calibration will be
shown in INCA

Return Value None

Description  Adds another group path where the object is to be seen in INCA.

4.17 Writing Dataset to MDF File

The MDF write functionality allows you to take any Simulink” dataset, for example
one generated by the logging of Simulink” signals, and output it to an MDF file.

To write dataset to MDF file via MATLABﬁ command line

— Callthe commandMScripts.MDF.Write (parameterl,

‘parameter2’ , parameter3).

parameterl MATLAB®/Simulink” dataset you want to write
to an MDF file.

parameterZ2 Path to which you want to write the MDF file.

parameter3 Parameter instructs the MDF writer to copy the

most recent value of every signal in the dataset
to the last timestamp. This additional data
point is added to help an MDF viewer, such as
ETAS MDA, to display a line instead of just one
point. Possible values are true or false.

This parameter is optional.

Example:
MScripts.MDF.Write (logsout, ‘D:/output.mdf’, false)

The following screenshot shows the MDF write functionality in
MATLAB®/Simulink” and MDA. Signals were logged using the signal logging fea-
ture of Simulink”. Then the MDF write command MScripts.MDF.Write (log-
sout, ‘D:/output.mdf’) wasexecutedand the output was loaded into the
MDA.
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@ Note

You can set Simulink” to log signals with a repeated value every tick if you
setits Sample Time to -1.

If you use the lifetime callbacks of the model, you can set up Simulink” to
automatically call the MDF write functionality whenever a model is
paused, stopped, or saved, for example. Refer to the official MATLAB’
documentation on how to set up model callbacks.

To write an MDF file via GUI
1. Inthe Tools menu, click INCA-SIP > MDF Configuration.

The MDF Configuration dialog box opens.
2. Inthe MDF Export area, activate Use Signal Logging.

or

Click Change Settings and in the Simulink” Configuration Parameter dialog
box on the Data Import/Export tab, activate the signal logging setting.
In the Export File field, define the path and the name of the MDF file.

4. Tohold the last signal value until a signal changes its value in the MDF
export file, activate Hold Last Value.

5. To create an MDF export file automatically when you click the Stop button
in Simulink”, activate Automatically Export on Stop.

©. Toautomatically increment the filename of the MDF export file, activate
Auto Increment Filename.

In case of a file collision, INCA-SIP appends an additional counter xx to
the end of the file name. In case of a new session or a change of the file
name, INCA-SIP resets the counterto  01.
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@ Note

If this option is deactivated, previously created MDF export files will be
overwritten.

7. Toexport the MDF file immediately, click Export Now.
8. Click Apply.
9. Click OK.

4.18 Using INCA Remotely

Remote INCA access is required if you want to use one machine to operate a
Simulink” model while using INCA on another machine to calibrate the Simulink”
model.

To run INCA remotely, INCA-SIP and INCA must be installed on the INCA machine
and the remote machine.

Setting up the Remote INCA Connection
To set up the Remote INCA Connection, perform the follwing actions:

— "To adjust the Window Component Services settings " below

— "Toadd a user or a group to the INCA DCOM Config" below
— "To adjust the INCA-SIP settings in MATLAB®" on the next page

To adjust the Window Component Services settings

1. Open the Windows desktop app Component Services.

2. Expand all Component Services folders.

3. Right-click on My Computer and select Properties.

4. Inthe Default Properties tab, make the following settings:
» Enable Enable Distributed COM on this computer.
» Set the Default Authentication Level to Connect.
» Set the Default Impersonation Level to Identify.

5. Click Apply.

6. Click OK.

To add a user or a group to the INCA DCOM Config

1. Open the Windows desktop app Component Services.
2. Expand all Component Services folders.

3. Inthe DCOM Config folder, right-click on INCA7x Server and select Prop-
erties.

4. Select the Security tab.
5. Inthe Launch and Activation Permissions list, enable Customize.
6. Click Edit.



In the Group or user names list, click Add and add a new user or a new
group.

8. Click OK.

9.
10.
11.
12.

In the Permissions for SYSTEM list, enable all Allow check boxes.
Click OK.

Click Apply.

Click OK.

If you add a user or a group, ensure that:

— The added user is the same user who is using MATLAB®.

— The added group contains the user who is using MATLAB®.

To allow DCOM communication through the firewall, you may need to change the
firewall settings. For more information, refer to the Microsoft documentation.

To adjust the INCA-SIP settings in MATLAB®

1.
2.

3.

In the Tools menu, select INCA-SIP > Configuration.
Enable the following settings:

* Open INCA On Connect

* Remote INCA Connection

In the INCA Machine DNS Name/IP Address field, enter the host name or
the the IP address of the INCA remote machine.

In the Root Network Path field, enter a common UCN path that the INCA
machine and the MATLAB® machine can access.

The Root Network Path is used to save the INCA database, the A2L file,
and the S19 file. The data will be saved in the remote network path if the
configured path is relative. In such case, the path is resolved relative to the
configured UCN path. If the path is absolute, then it is the responsibility of
the user to make sure that the INCA database path is accessible by the
remote INCA machine. The A2L and S19 path will be accessible by both
machines using the same UCN.

@ Note

Each ECU has its own TCP Port. Note that each ECU port must be allowed
as an incoming port on the MATLAB® machine by the firewall. In addition,
each ECU has the IP Address which INCA will use to connect to the XCP
Slave. If the selected address is not on the same subnet as the INCA
machine, INCA-SIP attempts to find an interface which is on the same
subnet as the INCA machine. If no such interface is found, manual user
action will be needed to identify the appropriate IP Address.
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Custom Hooks
INCA-SIP provides hooks to allow:

— Custom filtering
— Custom measurement and calibration naming
— Custom group naming
— Customization of variables
Some use cases of these hooks are:
— Filter unwanted calibrations and measurements

— Create custom own naming conversion for calibrations, measurements,
and groups

— Set the display identifier etc..
Custom hooks are function pointers to MATLAB® functions.
The hooks can be setinthe MScripts.Configuration by calling:

— "setVariableFilterFunctionHandle" below

— "setVariableCustomizationFunctionHandle" on page 46

— "setVariableRenamingFunctionHandle" on page 48

— "setGroupRenamingFunctionHandle" on page 49

The hooks can be reset inthe MScripts.Configuration by calling:
— clearGroupRenamingFunctionHandle
— clearVariableCustomisationFunctionHandle
— clearVariableFilterFunctionHandle
— clearVariableRenamingFunctionHandle

TheMScripts.Configuration classis asingleton and is global to the
MATLAB" Instance.

To get the instance of this class

1. ExecuteMScripts.Configuration.getInstance ().

Any changes done to the configuration class are lost when MATLAB" is closed.
Therefore, custom hooks would need to be set every time MATLAB® is opened.

setVariableFilterFunctionHandle

Each calibration or measurement added to a data model is passed to the custom
hook if it is set. If the custom function accepts this calibration, it is added to the
data model otherwise it is skipped and none of the remaining custom hooks are
called with regards to this calibration or measurement.
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Hook Function Signature

Function bKeep = variableCustomFilter (type, vari-

ableInfoWrapper)
Para- bkeep returns
meters true If the calibration or measurement is to be kept.
false If the calibration or measurement is to be filtered
out.
type char(] Can be one of the following constants:

MScripts.DataModelBase.Sim-

ulinkdWorkspaceCalibration

MScripts.DataModelBase.DLLCal-

ibrationAxis

MScripts.DataModelBase.DLLCalibration

MScripts.DataModelBase.DLLMeasurement

MScripts.DataModelBase.Sim-

ulinkCalibrationAxis

MScripts.DataModelBase.Sim-

ulinkCalibration

MScripts.DataModelBase.Sim-

ulinkMeasurement

vari- Instance of MScripts.VariableWrapper.
ableln- The variableInfoWrapper iSused to determ-
foWrapper ine which calibration or measurement is currently

being processed. For more information on how to
use the variablelnfoWrapper, refer to
"MScripts.VariableWrapper" on page 51.

@ Note

During this hook, only getters should be used on the vari-
ableInfoWrapper. Any changes needed to be effected to this calibration or
measurement can be effected in the setvari-

ableCustomisationFunctionHandle hook.

For an example of this hook, see the CustomHooks variableCustomFilter.m
script located in the "SIPDEMO" folder.

Variable selection before using a custom hook
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All Sources (Not Filtered, 7/7 Visible)

Name « |Role

All_Samples

@175 1 D_Lookup_Table
@'E 42 calibrationToFitter

BT 43 LineToFilter

'?4} OriginalCalibrationName
.*E"'Ié OriginalLineName

@?4} RealTimeBlock.mode

n‘?ﬂé RealTimeBlock.real TimeMultiplier

Variable selection after using a custom hook

All Sources (Not Filtered, 5/5 Visible)

8
Name 4 Role £

i
oy
i
=

@ #%% 1 D_Lookup_Table

(T =@ originalCalibrationiame

.*E"'Ié OriginalLineName

;‘*E"%é RealTimeBlock.mode

\‘ﬂ(::hﬂé RealTimeBlock.real TimeMu tiplier

419.2  setVariableCustomizationFunctionHandle
Each calibration or measurement that passes the filter function stage can be cus-
tomized in this custom hook. To better understand what can be customized,

refer to "MScripts.VariableWrapper" on page 51.
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Hook Function Signature

Function variableCustomization (type,

variableInfoWrapper)

Para- type char(]
meters

Can be one of the following constants:

MScripts.DataModelBase.

Sim-

ulinkWorkspaceCalibration

MScripts.DataModelBase.

ibrationAxis

DLLCal-

MScripts.DataModelBase.

DLLCalibration

MScripts.DataModelBase.

DLLMeasurement

MScripts.DataModelBase.

ulinkCalibrationAxis

Sim-

MScripts.DataModelBase.

ulinkCalibration

Sim-

MScripts.DataModelBase.

ulinkMeasurement

Sim-

vari-
ableIn-
foWrapper

Instance of MScripts.VariableWrapper.

The variableInfoWrapper iS used to determ-
ine which calibration or measurement is cur-
rently being processed. For more information on
how to use the variableinfoWrapper, refer to
"MScripts.VariableWrapper" on page 51.

For an example of this hook, see the CustomHooks vari-
ableCustomization.m script locatedinthe "SIPDEMO" folder.

Variable selection before using a custom hook

Variables

CustomHooks (Not Filtered, 7/7 Visible)

8
Name a Role IEJ
| @l= a1 D Loakup Tabk Refarenced
@ T4 calbrationToRe Referenced
B T4 LinaToFilter Refaremced [®]
@ T4 OrigimalCalitratiohlae Refaremced
B E 4 origalLinatiars Referenced [@]
@ T 4 ResMmeBlodmode
@ T4 RealMmeBlock realMimeMulipher

Variable selection after using a custom hook

Variables CustomHooks (Not Filtered, 8/8 Visible)

Sources

= 19 Al Sources
S o Cuttomtiosks
% (3 Rasters
Grougs
[ mTas 52
HesLootaroun
gy Axes
gy Calbrabors
Meanrements

1 -
=48 LD _Lookup TableBreskpossisfodimenon] Faferenced

@199 1 0 Lockup Table_sDispiaimth Referented

@ T 49 CalibrabionToFilter_sDisclaylenther Referenced

T 4@ LineTeFiter_sDisplayiette Eeferenced [e]
@ T4 onginalCalibratianName_sDisplyilertie Riferenied

T 4@ onginalliseName_sDisplaykenifier Referenced E!
@ T4 RealTimeSiock_sDisplayidenther

@ T9P RealTimeBlock_sDisplaylenier
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setVariableRenamingFunctionHandle

Each calibration or measurement that passes the filter function stage can be
renamed in this custom hook. Calibrations added due to the show work-
space/data dictionaries variables arenot passed to this hook as these
cannot be renamed.

Hook Function Signature

Function

mappedName = variableNameMapper (incaSIPName, type,

variableInfoWrapper)

Para-
meters

mappedName

New desired mapped name. Cannot be empty.

incaSIPName

Suggested name from INCA-SIP

type char/(]

Can be one of the following constants:
MScripts.DataModelBase.DLLCal-

ibrationAxis

MScripts.DataModelBase.DLLCal-

ibration

MScripts.DataModelBase.DLLMeas-

urement

MScripts.DataModelBase.Sim-

ulinkCalibrationAxis

MScripts.DataModelBase.Sim-

ulinkCalibration

MScripts.DataModelBase.Sim-

ulinkMeasurement

vari-

ableInfoWrapper

Instance of MScripts.VariableWrapper.

The variableInfoWrapper isused to
determine which calibration or measurement is
currently being processed. For more inform-
ation on how to use the variablelnfoWrapper,
refer to "MScripts.VariableWrapper" on

page 51.
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— If the mapped name is not ASAP2 compliant, INCA-SIP will
correct this to make it compliant.

— If the mapped name is already used, INCA-SIP will append _x
where xis 1toinf.

— TheincaSIPName is the suggested name and it can also be
non-unique and/or non ASAP2 compliant at this stage

— During this hook only getters should be used on the vari-
ableinfoWrapper. Any changes needed to be effected to this
calibration or measurement can be effected in the setVari-
ableCustomisationFunctionHandle hook.

For an example of this hook, see the CustomHooks variableNameMapper.m
script located in the "SIPDEMO" folder.

Variable selection before using a custom hook

All Sources (Not Filtered, 7/7 Visible)

MName « |Role

All_Samples

W12 1D _Lookup_Table

@’T %@ calibrationToFiter

.E-@ LineToFilter (@]
@cC %ﬁ Qriginal CalibrationName

.*E"'lj OriginalLineName E
('T 42 RealTimeBlock.mode

;‘ﬂ(::"@ RealTimeBlock.real TimeMultiplier

Variable selection after using a custom hook

CustomHooks (Not Filtered, 7/7 Visible)

i}
Name [DisplayID]  |Role E

1]
=]
=

W 1%%9 1D _Lookup_Table Referenced

\J?@ CalibrationToFitter Referenced

;‘?4} CustomCalibrationName Referenced

.?Q CustomlLineName Referenced E

.*(:;"'lj LineToFilter Referenced E1

L ﬂlt::'-=if RealTimeBlock.mode

L *(::'—4} RealTimeBlo ck.real TimeMultiplier

setGroupRenamingFunctionHandle

Each group path for all the calibration or measurement that passes the filter func-
tion stage can be renamed in this custom hook. Each unique path will only be
passed to the hook once.
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Hook Function Signature

Function mappedName = groupNameMapper (incaSIPName, type,

metadata)

Parameters mappedName New desired mapped name. Cannot be empty.

incaSIPName Suggested name from INCA-SIP.

type char[] Canbe one of the following constants:
MScripts.DataModelBase.SimulinkGroup

MScripts.DataModelBase.DLLGroup

metadata Full path of the group, e.g. /mod-
el/subsystem/subsubsystem. The
metadatals used to determine the group that
is currently being processed.

@ Note

— If the mapped name is not ASAP2 compliant INCA-SIP will cor-
rect this to make it compliant.

— If the mapped name is already used INCA-SIP will append _x
where x is 1toinf.

— TheincaSIPName is the suggested name and it can also be
non-unigue or non ASAP2 compliant at this stage

For an example of this hook, see the CustomHooks groupNameMapper.m
script located in the "SIPDEMO" folder.

Variable selection before using a custom hook

Variables

Sources
=] l-‘ﬁ:] &ll Sources
[= «Z» CustomHooks
:3 Rasters
= [@ Groups
= l@ CustomHooks
g eTas_sip

Variable selection after using a custom hook

Variables

Sources
B F souces |
= < CustomHooks
:3 Rasters
=2 [@ Groups
= [@ NewCustomMaodelMame
& ETas s
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MScripts.VariableWrapper

This class is used to wrap calibration and measurements and to allow access for
changing specific aspects of its properties.

4 Working with INCA-SIP | 51

Properties and functions that can be changed

Property sDisplayIdentifier
Description A2L Display Identifier Entry
Usage with MScripts.DataModelBase.DLLCalibration
Variable MScripts.DataModelBase.DLLMeasurement
Types
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim-

ulinkWorkspaceCalibration

Field Type  char[]

Property dMin

Description A2L variable minimum valued allowed. Used by INCA.

Usage with MScripts.

DataModelBase.

DLLCalibrationAxis

Variable MScripts

.DataModelBase

.DLLCalibration

Types
MScripts

.DataModelBase.

DLLMeasurement

MScripts

.DataModelBase.

SimulinkCalibrationAxis

MScripts

.DataModelBase.

SimulinkCalibration

MScripts

.DataModelBase.

SimulinkMeasurement

MScripts.

DataModelBase.

Sim-

ulinkWorkspaceCalibration

Field Type number
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Property dMax

Description  A2L variable maximum valued allowed. Used by INCA.

Usage\Nhh MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.DLLCalibration

Types
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Field Type  number

Property sDescription

Description AL2 variable description entry.

Usage\Nhh MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.DLLCalibration

Types
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Field Type  char[]
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F%opeﬁy numOfDimensions

Description Number of dimension of the data the variable represents.

Usage\Nhh MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.DLLCalibration

Types
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Field Type  number

F%opeﬂy dataAccessInfo

Description Used to determine which calibration or measurement this variable
wrapper represents.

Usagevﬂth MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.DLLCalibration

Types
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim—
ulinkWorkspaceCalibration

Heijype MScripts.AccessInfo
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Function addGroupPath(<char[] newPath>)

Description Adds another A2L group to this variable.

Usage\Nhh MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.DLLCalibration

Types
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Field Type MScripts.AccessInfo

Parameter New A2L group in which this variable is to be shown.
newPath This path does not need to exists in the Simulink”

model. It can be any path.

Function makeComAxis

Description  Forces axis to be a COM axis in the A2L.

Usagevﬂth MScripts.DataModelBase.DLLCalibrationAxis

Variable MScripts.DataModelBase.SimulinkCalibrationAxis

Types

Heijype MScripts.AccessInfo

Property xAxisAccessInfo

Description  Used to determine which calibration axis this variable element rep-
resents.

Usage with  Can be used with the following variable types if numOfDi-

Variable mensions >=1:

Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Heijype MScripts.AccessInfo
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F%opeﬂy yAxisAccessInfo

Description Used to determine which calibration axis this variable element rep-
resents.

Usage with  Can be used with the following variable types if numO£Di-

Variable mensions >=2:

Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Heijype MScripts.AccessInfo

FWopeﬂy zAxisAccessInfo

Description Used to determine which calibration axis this variable element rep-
resents.

Usage with  Can be used with the following variable types if numO£Di-

Variable mensions >= 3:

Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Field Type  MScripts.AccessInfo

Property wAxisAccessInfo

Description  Used to determine which calibration axis this variable element rep-
resents.

Usage with  Can be used with the following variable types if numOfDi-

Variable mensions = 4:

Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.Sim-
ulinkWorkspaceCalibration

Heijype MScripts.AccessInfo
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@ Note

For all axisAccessInfo anexception can also be thrown if the axis in that
index is a non-editable axis (Fixed Axis).

— If calls are used on the wrong variable types, exceptions will be thrown.

— MScripts.AccessInfo isused to determine which calibration or meas-
urement this variable wrapper represents.

MScripts.Accessinfo

This class contains two parameters that are enough to determine which cal-
ibration or measurement is being represented. These parameters are
accessParameterl and accessParameter2. For better description, one can
make use of more meaningfull getters depending on the variable type.

If Vari- MScripts.DataModelBase.SimulinkCalibrationAxis

able

Type is MScripts.DataModelBase.SimulinkCalibration

The Block path is the path in the model where

Use getBlockPath _p P

the block is located.

The property name is the property in the block
getPropertyName ) p.p Y . p.p y

this calibration is representing.

Note Helper Function to get the name of the block using the access info:
blockName = MScripts.AccessInfo.getBlockName (<hAc-
cessInfo>);

If Vari- MScripts.DataModelBase.SimulinkWorkspaceCalibration

able

Typeis

Use getBlockPath The Block path model name.

The property name is the name of the work-

getPropertyName i
Space variable.
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If Vari- MScripts.DataModelBase.SimulinkMeasurement
able
Typeis
The Block histh hinthem | wher
Use getBlockPath e Block path is the path in the model where

the block is located.

The port number is the index of the line with

getPortNumber
respect to the outports of the block.

Note Helper Function to get the name of the block using the access info:
LineName = MScripts.AccessInfo.getLineName (<hAc-

cessInfo>);

If Vari- MScripts.DataModelBase.DLLCalibrationAxis
able . . .
_ MScripts.DataModelBase.DLLCalibration
Typeis
MScripts.DataModelBase.DLLMeasurement
Use The DLL name is the name of the DLL being

getDl1lName :
used in DLL mode.

The module offset is the memory offset where
getModuleOffset the variableislocatedinthe DLL. For more
information, refer to "DLL Mode" on page 31.

. . @
4.20 Supported Simulink  Block Types
INCA-SIP supports the following Simulink” block types:

Block Type Constant

Block Type Gain

Block Type Lookup

Block Type Lookup2D

Block Type Lookup3D

Block Type sfun_lookupnd

Block Type Stateflow

Prerequisites Parameters - Workspace Variables
Block Type LookupNDDirect

Prerequisites NumberofTableDimensions - 1-4
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Block Type
Prerequisites

S-Function & M-S-Function

Tunable - on

Visible - on

Enabled - on

ReadOnly - off

Block Type

Prerequisites

Interpolation_n-D & S-Function (FunctionName - sfun_
kflookupnd)

TableSource - Dialog

NumberOfTableDimensions/numbDimsPopupSelect - 1-4

Block Type ManualSwitch

Block Type PreLookup D & S-Function (FunctionName - sfun_idx-
search)

Block Type Lookup_n-D

Prerequisites

NumberofTableDimensions - 1-4
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Restrictions and Other Behaviors

This section contains a range of tips and information on restrictions and beha-
viors of INCA-SIP.

RAM Calibration

RAM calibration is not supported in INCA-SIP. RAM calibration allows calibration of
measurements. You can enable or disable this in the INCA user options. Such cal-
ibrations are represented in the Variable Selection Dialog as shown in the image
below.

om®

Sources
=] lﬂ:] All Sources
< Demo
= [E Demo=RAMCal
) Rasters
[@ Groups

Parallel Measurements with Other Hardware

When you use INCA-SIP, it is not supported to measure and calibrate with other
devices in INCA.

Pausing Measurements

If you use the "Pause Recording” function in INCA, you may notice in the sub-
sequent measure data analysis in MDA that there is no data or data has been
interpolated over extended areas.

This behavior deviates from that of measure physical hardware in which a paused
measurement in the measure file is displayed in the form of breaks of 1s.
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Tutorial

This tutorial presents a simple example in order to show how to operate INCA-SIP.
You find the "SIPDemo” model in the following directory:

<drive>:\ETASDATA\INCA7. 5\Demo\AddOn_INCA—SIP7 .5.

In this tutorial, you connect a Simulink” model to INCA, run the experiment and
make changes to the Simulink” model.

You can perform the following steps:
— "Toadd INCA-SIP to MATLAB®" below
— "Toconnect INCA-SIP to INCA” below

— "To calibrate and measure the model in INCA" below

— "To change the emulation mode" on the next page
To add INCA-SIP to MATLAB”

If you use your MATLAB’ version with INCA-SIP for the first time, then add INCA-
SIP to the MATLAB® path. For more information, refer to "Installation Path of INCA-

SIP” on page 15.
1. Open MATLAB".

2. Navigate to the "SIPDEMO" folder.

3. Toopenthe Simulink” model, double-click sipdemo.mdl.

The Simulink” editor opens and displays the model.
To connect INCA-SIP to INCA
1. Inthe MATLAB® Tools menu, select INCA-SIP >Connect to INCA.

An "ETAS SIP" block is added to the model. INCA is started and a folder
within the "INCASIP" database, a workspace, and an ECU project are cre-
ated.

To calibrate and measure the model in INCA

1. Inthe INCA "Database Objects” window area, open the folder INCASIP/-

sipdemo.

2. Double-click on the workspace @ "sipdemo_wsp".
The INCA experiment environment opens.
3. Select Variables > Variable Selection

or

=
click ™ or press SHIFT + F4.
The Variable Selection Dialog (VSD) opens.
4. Select the variable "SineWaveOutput”.

5. Right-click on the variable and select Add to... >Layer_1>New... > YT-
Oscilloscope.

6. Select the variable "SineWaveAmplitude”.
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7. Click OK.

The calibration and measurement variables are added to a new YT oscil-
loscope.

8. To start the experiment, click D or press F11.

The simulation in Simulink” and the measurement in INCA is started and dis-
played in the YT-oscilloscope.

9. To stop the experiment, click _ orpress F9.

@ Note

If you change the "SineWaveAmplitude" values in the INCA experiment,
the oscilloscope reflects these changes.

To change the emulation mode

1. Inthe INCA experiment environment, select Variables > Variable Selection

=
or click * = or press SHIFT + F4.

The Variable Selection Dialog (VSD) opens.

2. Select the calibration variable "RealTimeBlock.mode" and "Real TimeB-
lock.realTimeMultiplier”.

The default editor for the scalar variable opens. You can select a default
editor via the INCA user options.

3. Change the value of the "RealTimeBlock.realTimeMultiplier” variable to 4.
The simulation runs four times faster than real time.
or
Change the "RealTimeBlock.realTimeMultiplier” variable to 0.5.
The simulation runs slower than real time.
or
Change the "RealTimeBlock.mode" variable to Fast Emulation Mode.

The simulation runs at its fastest level.



Contact Information

Technical Support

For details of your local sales office as well as your local
technical support team and product hotlines, take a look at
the ETAS website:

www.etas.com/hotlines

ETAS offers trainings for its products:

www.etas.com/academy

ETAS Headquarters

ETAS GmbH
Borsigstral3e 24 Phone: +49711 3423-0
70469 Stuttgart Fax: +49711 3423-2106

Germany Internet: www.etas.com
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